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Overview 

What is the FDOT20##.C3D State Kit? 

The Florida Department of Transportation (FDOT) has developed CADD Standards for the production, delivery and 
processing of Florida transportation systems plans. The FDOT Engineering / CADD Systems Office (ECSO) produces 
a CADD Software Suite “State Kit” to coordinate these Standards for the Department’s approved design software, 
Autodesk® AutoCAD® Civil 3D 2015® (Civil 3D).  

The CADD Manual containing the CADD Standards may be downloaded from the ECSO website and viewed here:  
http://www.dot.state.fl.us/ecso/downloads/publications/Manual/default.shtm 

Included in the State Kit for Civil 3D: 

 Desktop applications launch folder ‘FDOT20##.C3D’  
 Content folder ‘FDOT20##.C3D’ containing all FDOT software suite applications and FDOT resource files 

including but not limited to; Blocks, Pay Item Database, Parts Catalog, Templates, Fonts, Linetypes, Plot 
Support files, Subassemblies and Tool Palettes. 

 Custom FDOT profile ‘FDOT20##C3D.arg’ and FDOT Ribbon.  
 

User Requirements for FDOT State Kit  

The FDOT State Kit for Civil 3D 20## is a stand-alone workstation configuration for Autodesk AutoCAD Civil 3D 2015. It can 

be installed alongside the FDOT State Kit’s for Civil 3D.. There is not a State Kit for Civil 3D 2013. 

 

 Microsoft® Windows® 7 or higher (64-bit only). Windows 10 requires the Autodesk® AutoCAD® 2015 
SP2 Microsoft® Windows® 10 Compatibility Hotfix (64-bit only). 

 Microsoft Internet Explorer 9 or higher 
 Microsoft .NET Framework Version 4.5  
 Microsoft Excel® or Microsoft Office® 2007 SP 1 or higher 
 Adobe® Reader 9.5 or greater 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

https://knowledge.autodesk.com/support/autocad-civil-3d/downloads/caas/downloads/content/autodesk-C2-AE-autocad-C2-AE-2015-sp2-microsoft-C2-AE-windows-C2-AE-10-compatibility-hotfix.html?v=2015
https://knowledge.autodesk.com/support/autocad-civil-3d/downloads/caas/downloads/content/autodesk-C2-AE-autocad-C2-AE-2015-sp2-microsoft-C2-AE-windows-C2-AE-10-compatibility-hotfix.html?v=2015
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Create Project 
 

1. Launch CreateProject3D. This application is installed with the FDOT State Kit, IT can be found in the in the 

installed application folder on the desktop or launch directly from the Windows Program Group.  

 

2. Verify that the Project Type is set to “FDOT AutoCAD Civil 3D Project” and the Parent Container Directory 
is pointing to the desired location. The primary information that needs to be completed is the FPI 
(Financial Project Identifier) and the Project Description (General Description). These fields will turn green 
when the amount of information is satisfactory. When complete select “FINISH”.  

 
3. You will receive a Create Project verification notice. Verify everything look correct and click OK. 

4. In PEDDS complete as much information as possible by moving through the tabs. The County, Road 
Number and the Project Manager information is vital for all sheets to be created. Select “Save Changes”. 
Select “OK” to dialog boxes that follow to confirm changes and updates to Sheet Sets, Project Summary 
Report and to confirm that the AutoCAD Project has been successfully created.  
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Creating a Sheet Set (.dst) File 
 
 The Sheet Set Manager organizes, displays and manages collections of drawing sheets. Each sheet is a layout 
in a drawing. 

 
1. Access Sheet set Manager by clicking the Sheet Set Manager icon on the Home ribbon Pallets Tab.  

Open the Sheet Set Manager and select the drop-down arrow and pick the “New Sheet Set…” option. 
 

 
 

2. When the Create Sheet Set wizard opens, select to use “An example sheet set” then “Next”.  
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3. Select the ‘Browse to another sheet set to use as an example’ and pick the ellipsis button to browse to the 
FDOT MASTER SHEET SET TEMPLATE located in the data folder of your project. This template is delivered 
when a project is created and has the project information you entered during Project Creation. Click 
‘Next’ when you return to the ‘Create Sheet Set’ dialog box.  
 

 
 

4. Name your Sheet Set then select the ellipsis button to navigate to your project location. Store the file in 
the \eng_data folder under the corresponding discipline folder. 

 At this point you will also have the opportunity to add any additional information that was missed at the 
 beginning during the Create Project setup. Select “Sheet Set Properties” to add or edit the Custom 
 Properties. 
 

  
 
5. Click “NEXT”, confirm the Sheet Set Preview setting and select “FINISH” when complete. Your new Sheet 

Set will display in the Sheet Set Manager dialog box.  
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Create Key Sheet and Add to Sheet Set File  
 

Key Sheets are already created in the FDOT State Kit along with layouts for the different types of funding and 
map requirements.  

 
1. Using the Create File application on the FDOT ribbon create a Key sheet file. Click on the “Create File” icon 

under the FDOT tab. Follow the steps to create a new Key Sheet file inside your current project directory 
under the Roadway Project folder. 

 
 

2. Located on the bottom of the drawing file are several project types available. Select for this example “FF 
w_Maps” (Federal Funds with Map) layout with for your project type and delete the remaining. Hold 
down the “Shift” key and select the others tabs, right-click and select “Delete”. 

 
3. Locate the project area in viewport in the layout mode. Select a desired scale for viewport and lock View 

port in place. Save your drawing.  

 
 
 

Adding Sheets Manually to a Sheet Set File 
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1. Right-Click on the component name for the Key Sheet and select “import Layout as Sheet” 

  
 

2. The current drawing will already be in the list. You can load several additional drawings by selecting the 
“Browse for Drawing” option to import any other drawings with layouts you wish to add to the Sheet Set.  
 

3. Select the layout(s) to be imported into the Sheet Set. Layouts not selected will not be available for 
electronic delivery through the Sheet Set Organizer. Make sure that the Prefix sheet titles box is 
unchecked unless you want the file name prefixed to your layout. 
 
 

 
4. Review the added layouts and select “import Checked” to finish adding sheets. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Data Short Cuts (Data Referencing Alignments, View Frames…) 

 
Add alignment to design file. This exercise will assume that the alignment file has been created but not yet shared. 
We are going to add an alignment to our Data shortcuts so we can access it in another drawing. 
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1. Open the ALGNRD01.dwg file found in the roadway folder of your project. Execute Zoom Extents and save 

the file. TIP: To Zoom Extents, either type in ZE at the command prompt of double click the wheel on your 
mouse. 

2. On the Toolspace Pallet, Prospector tab right click on the Data Shortcut(s) section and select “Set Working 
Folder…” and navigate to the project folder location (i.e. C:\E\projects). The path will display next to the 
Data Shortcuts title showing the first project with Data Shortcuts. Next right click again on Data 
Shortcut(s) and select “Set Working Folder…” and select the Name of your project from the list provided.  

 
 

3. On the Toolspace Pallet, Prospector tab right click on the Data Shortcut(s) section and select “Create Data 
Shortcuts…” and select your Alignments. Click “OK”. Expand the Alignments sections to see your 
Alignments added to your Data Shortcuts.  

 
 
 

 
 
 
FDOT Subassemblies: Existing Features 

The custom FDOT Existing Features subassemblies utilizes existing survey data to create a corridor with below 
ground features; pavement, curbs, shoulders, sidewalks, as well as at grade traffic separators, guardrails and 
fences for cross sections.  Cross sections documentation of Utilities and Drainage, and proposed which use a 
different process and can be added to drawing separately after creating the existing feature corridor. 
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 Process Description: 

 Drawing Prerequisites Preparation 

 Create an Existing Features Assembly 

 Create the Existing Features Corridor 

 Edit the Existing Features Corridor 

 Generate Cross Sections 
 

 3D Model Object Prerequisites 

 Alignments – Use Centerline of Construction alignment (design baseline).  
 Profile – Existing ground profile along the design baseline. 
 Surface – Existing ground surface model. 

 
 Geometry Prerequisites 

 Existing Topography- TOPORD##.dwg.  
 Right of Way lines (Optional) – RW######.dwg 
 No duplicate geometry 
 All Target geometry must be on correct layers. 

 
 Geometry Prerequisites – Layers 

 Refer to subassembly help documentation for latest required layers. 

 

 
Drawing Preparation – Create Existing Features Corridor Model File 

1. Launch the Create File application from the FDOT Tab 
2. Select For Discipline ROADWAY, File Group > Roadway design Files File Type >Corridor Design Model. 
3. Select Create and Open File 
4. Check that the correct Coordinate zone is set 
5. Save the File as CORRID##-Exist 



AutoCAD Civil 3D FDOT State Kit – Guide 

Copyright © 2016 Florida Department of Transportation Page 11 
 

 
Create Existing Features Assembly 

1. Create Assembly with the name ‘Existing Feature’ 
2. Left-click select on the Existing Features subassembly from the tool pallet to expose the parameters in the 

Properties Palette 
3. Right-click select to open the help document. Check that the layers in the source drawing match. 
4. Check and adjust the parameters 

 

Create Existing Features Corridor 
1. Create a Corridor named ‘Existing Features’. 

 A Project may have secondary roadways with secondary alignments. Create separate Corridor 
drawings and name them with their respective corridor names appended when practical. 
Example, ‘Existing-2ndSt’. 

 Special purpose Corridors should not be combined with the Existing Feature Corridor. 
2. Select the Base line and the Existing grade Profile. 
3. Select the desired Station Range. Tip: To improve performance if needed, select sequential smaller station 

range for initial processing for faster review and editing. Set the entire desired corridor station range after 
editing. 

4. Set Frequency to Apply to Assemblies. 

 
Create Existing Features Corridor 

1. Set Targets 

 Set the EG Surface to use for connection. Tip: Civil 3D will NOT flag the corridor to be rebuilt if the 
LAYER targets are modified. To update the Corridor after adjustments are made, right-click and 
choose force rebuild to update changes made to the corridor. 
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Edit the Existing Features Corridor 
After you review the model you will make adjustments to refine. 

 Examine intersection and driveways and add EOP extension across gaps at station sample. Draw 
targets on layer ‘PaveAsph_eop’. 

 Sidewalks need a Front and Back Line. 

 Traffic Separators must lie between pavement pairs. 

 Guardrails and Shoulders cannot lie between pavement geometry. 

 Guardrails must be on the correct side layer in the direction of the alignment. (Ex: RT or LT). 

 To limit the number of pavement lines searched, create a line or polyline on ‘Scratch2’ to exclude 
area or pavement that is not required on the sections. 

 
 

 
Cross Sections - Create new drawing to derive new Cross Sections from. 

1. Launch the Create File application from the FDOT Tab 
2. Select For Discipline ROADWAY, File Group > Roadway design Files File Type >Roadway Cross Sections 

(RDXSRD##) 
3. Select Create and Open File. 
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4. Check that the correct Coordinate zone is set. 
5. Create Data Reference from Data Shortcuts for Existing Ground Surface and Project alignments. 

 EG in GDTMRD## drawing source file 

 PFG-RT in ALGNRD## 
6. Create external reference (XREF) for CORRRD##-Existing.  This is the Corridor file that contains the existing 

features corridor. 
7. Choose ‘Sample lines’ located on the Home ribbon in the Profile and Section View Panel 
8. Select the Alignment that exist in the drawing or press enter to select the name from the dialog box. Press 

enter for the ‘Sample Group’ dialog box. 
9. In the ‘Create Sample Line Group’ dialog box, verify that the correct Name, Sample line Style and Sample 

line label style is correct. Make sure that the desired Data sources to sample are selected. Select OK and a 
‘Sample Line Tools’ tool bat will appear. Note: Under the ‘Type’ Colum, the Arrow on the icon signifies that 
the Data is being derived from Data Shortcuts. 

 
10. Select ‘From Corridor stations’ from the Sample Line Tools tool bar. 
11. Use the next dialog box to create sample lines along an alignment. You can adjust Sample line location 

and swath length by selecting the lines and adjusting the grips accordingly. Save you file. 
 
 

Create Multiple Views - Create multiple Section views for a group of sample lines along an 
alignment. 

 Unlike, plan and profile sheets, section sheets can only be automatically created in the same file 
containing Sample Lines. 

 
1. Choose ‘Create Multiple Section Views’ located under the ‘Sections Views’ pull down menu on the Home 

ribbon. 
2. Click ‘Next’ to walk through the following steps to create Sheets. 
3. Select the Alignment and Sample line group name. Specify the Station range for the Sections Vies. Adjust 

the Sections View Style to anything other than _No Display in order for the labels to be shown. Select 
Next>. 

 
 

4. Modify the Placement options to use the correct cross section template and scale. The Group Plot Style 
will remain FDOT Group Plot. Select Next> 
Note: Cross Sections Template path is location is installed in the following directory: 
C:FDOT20##.C3D\Data\Templates\Sheets\Roadway|… 
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5. The Offset Range and Elevation range Sections will remain at the default settings. These can always be 

adjusted later on in the design process. Click Next> twice till you reach Section Display Options. 
6. In sections Display Options section confirm that the correct sections to draw are present. Also confirm 

that the correct Style is assigned to the sections being drawn. Click NEXT> 
7. On the Data Band sections, confirm that FDOT Page Plot is selected for the band set and that the location 

is set to Bottom of section view. Select ‘Create Section Views’. 

 It is important that you add sample lines to the same baseline used in the corridor if you want your 
sections to show design and existing conditions together. This will ensure your sections display 
correctly. 

 Use Code Set Style ‘FDOT_Xsection_Existing’ for existing dashed display lines. 
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Create Section Sheets – Creates Section Sheets 
 Unlike, plan and profile sheets, section sheets can only be automatically created in the same file 

containing Sample Lines. 

 Excessive numbers of Layouts/Sheets (>20) can affect performance. You May manually copy the 
drawing and divide the range of Sheets by deleting Layouts, making sure you do not have duplicate 
sheets. 

1. Select the ‘Create Sections Sheets’ icon on located on the Output Tab in the Plan Production panel. 
 

 
 

2. Select the Alignment name, Sample Line group name and Sections view group name. 
3. Layout Setting – Name that’s automatically created and assigned to layout tabs. Ex: Sections Sheet-

<[Parent Alignment]> - <[Sample Line Group Name]> 
4. Sheet Set – Add to existing sheet set. Click on the ‘…’ icon to browse to your existing Sheet Set (.dst) file. It 

should be located in your eng_data folder in the Roadway category. 
5. Select ‘Create Sheets’ and ‘OK’ to confirm that you drawing will be saved. 
6. Sheet Seta Manager will launch. Click on your section view group sheet to view your drawings. 

 

 
 
 
 
 
 
Plan Productions 
 
 In order for the Plan production tools such as Creating view frames and Creating sections to function properly, 
certain Civil 3D object are required in your drawing file.  For example, Alignments are required to create View 
Frames, and Sample lines, defined Profiles are required to create profile views.  In the following steps, we will 
examine how to Create Data shorts and share that data between drawings in order to run through some of the 
Plan Production commands. 
 

Data Short Cuts – Create Data Shortcuts for Plan Production 
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Data Shortcut provides a direct path to the location of a shareable source object such as Alignments, Surfaces, 
Pipe Networks, Pressure Networks and View Frame Groups. In a single operation, you can create data shortcuts for 
multiple objects in a source drawing. The data shortcut is used only for the creation of data references. 
A data reference is a read-only copy of a source object, inserted into another drawing, often called a consumer 
drawing. From the Prospector tab, you can select a shortcut for an object and create a reference to that object in 
the active drawing. The data reference maintains an active link to the source object in the source drawing, without 
relying on the data shortcut.  
 
 The following steps we will add an alignment to the design file. This exercise will assume that the alignment 
file has been created but not yet shared. We are going to add an alignment to our Data shortcuts so we can access 
it in another drawing. 
 

1. Open the ALIGNRD##.dwg file found in the Roadway folder in your FDOT project directory. Execute the 
Zoom Extents command and save the file. Tip: To zoom Extents either type ZE at the command line or 
double click on the wheel on your mouse. 

2. On the Toolspace Pallet, Prospector tab, right-click on the Data Short(s) section and select ‘Set Working 
Folder…’ and navigate to the project folder location (C:\E\Projects…) The path will display next to the Data 
Shortcuts title showing the first project with Data Shortcuts. Next right-click again on the Data Shortcut(s) 
and select ‘Set Working Folder…” and select the name of your project from the list provided. 
 

 
 
 
 
 
 
 
 
 
 
 

3. On the Toolspace Pallet, Prospector tab right-click on the Data Shortcut(s) section and select ‘Create Data 
Shorts...’ and select your Alignments. Click ‘OK’. Expand the Alignments sections to see your Alignments 
added to your Data Shortcuts. 
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Create View Frames 
 View Frames are used to represent rectangular areas along the alignment that will be displayed on 
Plan/Profile or Plan only sheets. You can only create View Frames when an alignment is present. 

 
1.  Create a new drawing called CLIPRD## .dwg using the FDOT Create File tool. Select the ‘Clip Borders’ option 
from the list provided. 

 
 
 
 
 

1. Right-click on Data Shortcuts and Data Reference the Alignment into your new drawing. In the ‘Create 
Alignment Reference’ dialog box select the appropriate Alignment style and Alignment Label set from the 
pull down menu. Click ‘ok’ when finished. Expand the ‘Alignments’ tree in Tool Space Pallet to confirm 
your Alignment has been referenced. You can Zoom Extents to view the Alignment in your drawing. 



AutoCAD Civil 3D FDOT State Kit – Guide 

Copyright © 2016 Florida Department of Transportation Page 18 
 

 
2. Select the ‘Output’ tab on the ribbon and then select ‘Create View Frames’ icon on the Plan Production 

Panel. 

 
3. Choose the desired Alignment and Station range for creating Sheets then select NEXT. 
4. For Sheets select the type of sheets that you want to generate. Click ‘…’ icon and browse to the FDOT 

State kit directory: (C:\FDOT20##3.C3D\Data\Templates\Sheets\Roadway\...) 
5. For Plan View only, select the SHPLAN.dwt. Choose the desired scale from the ‘Select a layout to create 

new sheets list’. Click OK to return to the ‘Create View Frames’ dialog box. 
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6. Specify the View Placement along the alignment. Select ‘Next’. 
 

 
 

7. Define a View From Group name to help you identify what the View Frame Group is for. Example Plan-
40Scale<[View Frame Group Alignment Name(cp)]>. The portion in brackets means that Civil 3D will 
automatically place the Alignment name in the View Frame Group name. 

 

 
 

8. The Name, Style and Labels already have defined FDOT styles assigned to them. 
9. Click ‘NEXT’ to continue. 
10. Choose to insert match lines automatically and how they are placed and names. 

 
11. Choose the Positioning, Match Line Style, and Labels Styles that will define how your Match Lines will 

appear in your drawing. FDOT styles have been provided for you. 
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12. Since we are creating Plan View only, the Profile Views are greyed out. Click on ‘Create View Frames’ to 
place frames into the drawing. 

13. Select the newly generated View Frames in model space and using Grips, adjust the frame as needed. 

 
 

14. Right-click on Data Shortcuts… in the prospector and select ‘Create Data Shortcuts’. Select the View 
Frames Group name and click OK. 

 

 
 

15. Select the objects for sharing, then click OK. 
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Create Sheets Wizard 
 
After we create view frames we will create sheets using the Create Sheet Wizard. 
 

1. Using the same CLIPRD## file created in the previous steps, attach reference (xref) DSGNRD## and 
TOPORD## (Since drawings are going to be created/duplicated from this file we want to use the 
‘Attachment Method’ only option.  If you do not use this option you will end up with blank drawings. 

2. Create Data references (Profile if creating Plan and Profiles). Select and other data references if needed 
(surfaces, Pipe Networks….). 

3. Select the ‘Create Sheets’ command on the Plan Production panel located on the Output ribbon. 
 

 
 

4. Select the View Frame Group name. For Layout Creation settings, select how many layouts per drawing 
are created. Layout name ex: Plan<View Frame Group Alignment Name> <View Frame Start Station 
Value> to <View Frame End Station Value>. Make sure a North Arrow is selected. Click NEXT. 
 

 
 

5. Set the correct setting in the Sheet Set Option by adding it to your existing Sheet Set file locate in the 
…/Roadway/eng_data folder. This will ensure that your title block information is filled in correctly and 
consistent. Click NEXT. 

6. Since this is Profile views only, the next step is Data references. Select the Data you want referenced in 
your sheets (Pipe Networks, Surfaces…). 
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7. Select ‘Create Sheets’. 
8. Confirm that the drawings are correct. Delete extra layout tabs in your file. 
9. Clean up the .dst file is needed by moving the Subset into the correct component folder. Save your 

drawing. 
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Sheet Set Manager 
 
 The Sheet Manager manages layouts in your drawing files by considering each layout to be a “sheet” that is 
part of that “sheet set”. Whether the layouts are all in one drawing file or distributed among many drawings, you 
can manage and make changes to them all through the Sheet Set Manager. 

 
 A sheet set is a .dst file that contains the properties of the sheet set. You start with drawings that have model 
space content; these are your resource drawings. One layout for each drawing becomes the sheet in the sheet set. 
Therefore, a sheet set is a collection of layouts, one for each drawing. Sheet Sets help us keep track of file that are 
associated with o 
 
You can use Sheets sets to: 

 
 The FDOT Create Project application creates a Civil 3D FDOT project. The application can setup the appropriate 
project directory structure and other required components such as: 

 Financial Project Information # (FPID) 

 Project name 

 Project description 

 County 

 Project manager 

 ….many more 
 
 Information from the creation of the project is carried over to the .dst file template during the FDOT create 
Project process. You then use Civil 3D to create a new Sheet Set file based on the new or existing .dst templates in 
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the Data folder in your Project directory. Sheet Set properties are carried over to your new Sheet Set after 
creation. 

 
 

Import Existing and New layout in Sheet Set Manager 
 

1. Located on the bottom of the .dwg file are several layouts. Select your desired layout, right-click and 
choose Import Layout as Sheet... 

 

 
 
2. In the Import Layouts as Sheets dialog box the layout that you right-clicked on, will already be checked. 

You can browse for drawings at this point if there are other layouts that you would like to import at this 
time.  Select Import Checked when complete. 
 

 
 

3. In the SSM dialog box, select the new imported layout and drag it to your desired subset category.  Type 
“regen” at the command line to update your data text field in your sheet. 
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Using Sheet Set Manager to Organize Your Sheet 
 Once sheets are on the SSM we can then examine options that allow you edit sheet names and numbers, 
remove sheets and even rename your drawing file itself. 

 To edit names and numbers in your title blocks and in the SSM, right-click on a sheet name and choose 
Rename and Renumber. 

Enter your desired name and number and the Next or Previous buttons to move up and down the sheet list. 

 You can also change the name of the file itself to match the new sheet set title.  You can only rename the 
file as long as you do not have it currently open. 

To remove a sheet, right-click and choose Remove Sheet. You remove the sheet from the list, but you are not 
deleting the file itself. You are only removing the shortcut. 

 
 

Edit the DATA Fields Information 
 
There are two types of object data fields for Sheet Set Manager, Sheet Set Properties and Sheet Properties. 

 Sheet Set Properties displays information specific to the selected Sheet Set. 
If it applies to all sheets in the Current Sheet Set select the CurrentSheetSetCustom Field. Examples: City, 
State and Project #. 
 

 Sheet Properties displays information that is specific to the selected sheet, such as the sheet title, sheet 
number, and also display custom properties if any. 
If it applies ONLY to the Sheet on which the Field resides select the CurrentSheetCustom Field. Example: 
Drawn By, Revision, Date. 
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The following exercise demonstrates how to create a default Sheet Set and add custom sheet set fields. 

1. Select the Home tab, and locate the Pallets panel. Click on the Sheet Set Manager icon.  
2. Locate the drop-down menu at the top left corner and select New Sheet Set option to create a new Sheet 

Set file.  
3. When the Create Set dialog box opens, choose Existing drawings then click Next>. 
4. Give the Sheet Set a name. The Description is optional. Select a location where the new Sheet set data file 

(.dst) will be stored. Select the Sheet Set Properties button to access the Edit Custom Properties option. 
5. In the Custom Properties dialog box, select Add… 
6. In the Add Custom Property dialog box, for the name value enter CITY, leave the Default value, Value 
7. For Owner, since this is a City value and will more than likely be used on multiple sheets select Sheet Set. 

Repeat the same steps for STATE and ZIP. 
 

 
 

8. Click ok a few times until you return to the Create Sheet Set dialog box. 
9. Click Next> to for Choose Layouts option. 
10. Select browse, and browse for your drawing file that contains Mtext for your title block. (Note: you will 

not see the drawing file in the dialog box). Click ok. 
11. Select the name of the Layout out Tab that that you want to import. Click Next>, confirm you settings and 

select Finish. 
12. Double click the name of your sheet that you just imported in your new Sheet Set. 
13. Locate the Mtext you wish to convert to Data fields in your title block. Double click on the Mtext to enter 

Text Editor Mode. You will see the ribbon change accordingly. 
14. Highlight the text, and choose Field from the Insert Panel. 
15. In the field dialog box, under the Field Category drop-down menu choose, Sheet Set then choose 

CurrentSheetSetCutom under Field Names. 
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16. Under Custom property name you will see the custom Data fields you created. Choose CITY then click OK. 
17. Select Close Editor on the Ribbon. 
18.  The word Value will appear in your Mtext with a grey shade behind it representing a data field. 
19. To edit the field right-click on the Sheet Set title name in the Sheet Set Manager and choose properties. 
20. Locate Sheet Set Custom Properties category, click in the Colum on the left for CITY and enter in your 

desired City Name. Click OK to close out the dialog box. 
21. Type “regen” at the command like to see you text up with the new City name.   
22. Repeat the same steps for STATE. 

 
 The example below shows how to use the Drawing Properties fields to automate and assign names and values 
to create custom drawing properties. 
 

1. Choose the Application button> Drawing Utilities> Drawing Properties or choose File>Drawing Properties 
to open the Drawing Properties dialog box. 

2. Click the Summary tab. If you can use any of these properties, start here. For example, you can use the 
Title field for the drawing name. 

3. To add a custom field, c lick the Custom tab. Use a custom field for content that cannot use one of the 
fields that come with AutoCAD. 

4. Click the Add button. In the Add Custom Property dialog box, enter a field name and value and click OK. 
 

 
 

5. Repeat Step 4 for all of your custom fields. 
6. Click OK to close the Drawing Properties dialog box. 
7. To insert fields, start the MTEXT command and define the bounding box (or use the ATTDEF command to 

create an attribute definition). 
8. In the Text Editor (or Value or Default text box of the Attribute Definition dialog box), right-click and 

choose Insert>Field. You can do the same in a table. 
9. To find your custom fields most easily, choose Document from the Field Categories drop-down list. You’ll 

see all your custom fields listed. 
10. Choose the field you want, choose a format, and click OK. 
11. Repeat Steps 7-10 for all your custom fields. 
12. To use any of the fields that come with AutoCAD, again choose Insert>Field, choose a different category, 

field, and format. 
 
 



AutoCAD Civil 3D FDOT State Kit – Guide 

Copyright © 2016 Florida Department of Transportation Page 28 
 

 
FDOT Sheet Set Organizer 
 
Sheet Set Organizer (SSO) is an FDOT productivity tool developed for Civil 3D that works in conjunction with 
AutoCAD’s Sheet Set Manager (SSM) to help deal with multiple .DST files that can be produced for various portions 
and components of a plans set, perhaps SSM files even coming from various contributors. SSO helps the end-of-
the-line technician assemble the SSM files into a “comprehensive” set of data that can be plotted, reported, 
indexed etcetera. SSO also help automate the management and edits of the administrative data that appear in the 
title block area of plan sheets. The following will demonstrate SSO’s functionality, and how it can help save time 
and effort in Civil 3D plan production. 

 
 Examine the multiples areas of the SSO dialog box.–Load a project into SSO and examine the Sheet Set 
Files, Subsets, and Sheets List options in the SSO dialog box. 

 Launching  Sheet Set Organizer 

 Load a Project 

 Edit Sheets Sets 

 Save Sheet Set Changes 

 Create Output 
 

.DST Files – Layouts from specified drawing filers are imported into the sheet set manager. The associations and 

information that define a sheet set are stored in a sheet set data (.DST) file. 
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Sheet Set Organizer (SSO) – External program that runs out side of Civil 3D that reads .DST file. 

 

 
 
 
 

 
Load a Project into Sheet Set Manager 
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Edit Sheet Sets 
 

 
 
 
 
 
 
 
 
 
 
 
Save Sheet Set Changes 
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Main Dialog Interface Explanation 
 

 
 

A. SHEET SET ORGANIZER TAB: Name of all the DST file’s found inside the project folder directory.  
Select check box next to file name to show sheets in the subsets area of the SSO dialog box. 
Foreign Sheets are included in the SSO tab list as well. Choose Select All, Deselect All or invert to 
rapidly select files in the list. 

 
B. SUBSETS: Name of the subset categories inside of each DST file. Displays the file path and 

whether or not that subset contains and sheets. 
 

C. SHEET LIST: List the name of the sheets or layouts that are included in the Sheet Set. Also list the 
information about the status of that sheet along with the data fields that are included in the 
sheet itself. Use this list to edit an individual sheet or multiple sheets at once. 

 
SAVE: Launches AutoCAD and commits changes back to the DST file. 
 
Pull Down Menu Options 
 

 
FILE: Choose the Project directory to load DST files.  Choose top folder to load all DST files in subfolders. 
 
PLOT: Select options to Plot all, Un-plotted, out-of-date or Sheets by Sheet Set. 
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CREATE: Choose to create a detailed HTM or XML file report.  Choose Project.pdf to combine all single pdf’s into 
one single pdf document. 
 
VIEW: Choose to view reports with in SSO without having to manually browse to reports using windows explorer. 
 
FOREIGN SHEETS: Option to add multiple file types other than what is included in the DST file to SSO list for 
plotting. 
 
REPORTS: View All, Unplotted or Out-of-date Plot files. 
 
SETTINGS: Select different columns to display in the user interface along with the options to display a tool bar. 
 

 
 

 
 
 
 


